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 الخلاصة

المتقدم، ويتم داول ـداد الجـعأالخاص ب -الاكسليق ـبأستخدام تطب امةـنة العداد جداول الموازـعيهدف البحث الى أ

، بحيث يتم ادخال المدخلات للحصوول علوى المعلوموات صيغة التنفيذ الآلي –الماكرو عبر تصميم برنامج متضمنا لأيعازات

، ان عمليوة لا حسو  الجودول المطلوو ـ  كمـ سبقا عدت وبرمجية أ  ضية ددة وفق صيغ معادلات رياـالمحوالمطلوبة والبيانات 

تزل الكثيور ـخومموا ي   دخلوةالم   طياتـالمعوكثافة من  ، بالرغم ةعاليسرعة ببدقة متناهية وتتم ول على البيانات المطلوبة صالح

  .هدـت والجـمن الوق

 ، ماكروالمراجعة موازنة ، ايراد ، مصروف ، ميزان مفتاحية: الكلمات ال

 
 

The Expense of the General Budget Tables Using Excel Macro 

Program 
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Abstract  

 

The research aims to prepare the General Budget Tables using the advanced tables 

application - Excel by designing a program which includes the Macro- automatic execution 

formulas. The inputs can be entered the specified mathematical equations and pre-prepared 

software formats to obtain the required data works with precision and high speed despite of 

the dense input data which reduces a lot of time and effort. 
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 المقدمة
 لتوووو  ة متلاحقوووو لة   هائلوووو ل اتتقنيوووولأن تطوووو    

  لمجوووواوتن  منهووووا شووووت فوووو     شووووهعـا نوووووا نا  لحووووال 
 لآم   لذي جعل نووا نا  وتااوت  تقنية  لمعل ماتن 

 سوتم   ةة أن    .بعا  ث  ة  لمعل موات وُ افي لحاض  
 جعلووووووتفوووووو  ـووووووذ   لمجووووووا   ةسووووووا ن لتطوووووو   ت  لمتـووووووذ  
 [1] ة.  لأتمتية فلك  لمعل ماتات تع   ب لمجتمع

ميووة جوو ـ  أن  متأتيووة موون تأعيتهووا  لحاسووبات أـ
 قعةو لمعوحل  لمسائل  ل ةاضية  ل قميوة  مثللمهام اعبة 
ـووووذ   لنووووم موووون تخوووووةن   سووووت جا  موووو   ن بسوووو نة ـائلووووة
نشووووووووا     لمعل مووووووووات  تحليلهووووووووا      ل سوووووووو مات لتقووووووووا ة    

 [2] .ن ضها  
 ب فوو  وتخع م  لحاسوووية  سوووفوويكث ونا    لبحووويتوو

ة وع     لم  ونوووووويانات  لمطل بوووووة لجوووووو لبووووو ا   نلووووو و لحووووو
 :مايل ا نضموتمن امةو لع

 ي ضح  لم  ونة :ري ـالنظالجانب -الأول مبحثال أولا/
  لعام( عةويو ن  لم  جو  لماا ةف  م  ع ت  وي)لنل من 

ية وي ضح كيف :مليـالجانب الع-الثاني المبحث ثانيا/
م      و لمانب نامج يذ و تنف هيئةت ن لم  ونةجع    أنع ع 

-1ا متيهو لثلاث بنسخ ع   وج لفيذ لنل وش ح لآلية  لتن
 . ( لعامة -  لأجمالية)-2 لخااة(    -) لمف عة 

ش ح  :الاستـنتاجات والتوصيات-الثالث المبحث ثالثا/
 ن لبحث   لتطبيقخلا   ليها من تم  لت ال  لما

من خلا   لشاشات ت ضح  ل قع تم  . ماي ا  به
 لجع     لمنفذة له.ل

 الهدف من البحث
حسوووووواب جووووووع     لم  ونووووووة  لعامووووووة بأسووووووتخع م 
 لمووووان   لب نووووامج  لأنسوووول. أن مكننووووة جووووع     لم  ونووووة 
يعموووول نلوووو   فوووو   لنفووووا ة  اووووي   لأع    لمحاسووووب  فوووو  
 حووووع ت  قنفووووا،  لمووووال ن لأن  لحاوووو   نلوووو   لبيانووووات 
 لمطل بوووة يوووتم بسوووو نة نووووالية  ةعقوووة متناـووووية مووو   وخوووذ 

لووة   ختلافوووها  تحووعيثها بالأنتبووا  حجووم  لمعُوووطيات  لمعخ
ا  لوووووووع  ين   يضووووووا  لأنووووووع ع  لشووووووه ي   لسوووووون ي   تغووووووي ـ

للبويانات   لمُضومنة لحاوت  لتسوجيل   لت حوويل  نمليوات 
 لاوو و   لقوووبم  لمب بوووة   لمُعوووالجات  لقيعيفووووة مووا يووو ف  

[3] لسووووويط ة نلووووو   لم جووووو ع تن
 لآمووووو   لوووووذي ويقوووووا ن   
 بالايغة  لسابقة للأعخا   ليع ي.

 تطبيق المستخدمال
 Microsoftسل و لآنوووب نوووامج توووم  سوووتخع م 

Excel   و لمانووووفيووووه  لب مجوووو ق  بيوتطوووو ل   Macro   فوووو
 يضوووا    لتلقوووائ   لت حيووول  لشوووه ي   لسووون ي   نفيذ وية  لتووووآلووو
 .تجعةو لمس    وضافات   لتغي  ت ج  أ

 عينات البحث
 لنسوووووخة  -بنسوووووختيه  لب نوووووامج لقوووووع توووووم تنفيوووووذ

بأحووع   قسووم  لمووال لشووعبة  لم  ونووة لل (ة) لعاموو  لأجماليووة
ووووو لمُ  () لخااوووووة لنسوووووخه  لف عي وووووة    ن لوووووع  ئ  ة لنافوووووة عمم 
 ععـاونوووووحوووووعع    تابعوووووة لهوووووان ل لمعنيوووووة  لأقسوووووام   هوووووا ف  ن
 بالأمكوووان وةووواعة ن فووو   50   48ـنوووا بوووين  تسلسووولاتبال

 لوووع  ئ  فووو    ـوووذ   لعوووعع أ  تقلياوووه أنتمووواع  نلووو  نوووعع 
بالحاوو   نلوو  كفا تووه  لب نووامج  تابعووة لهووان  قووع أثبووت ل

 توووو في    لنتووووائج  لمطل بووووة بسوووو نه ناليووووة  عقووووه متناـيووووة
 .للجهع

 الجانب النظري  -/ المبحث الأولولاأ
 اندراسة الموازنة بشقيها الايراد والمصروف والميز 

 وازنةالم
أخووووذ للم  ونووووة  لحك ميووووة   ن  لمفهوووو م  لعلموووو 

ع  ك نها وتعمعن  أ س    نمق بكثي  ف  نالمنا  لي م  ة
قعي  وتا  نلوووو  توووووتقووووحيووووث وسابات وبيانووووات ماليووووة  حوووو

 لسياسوات  أنعكاس لج ـ  بل ـ  ...نوفقات ل   ت   عوي و
 ة  لمووال  ذ تووهموو   لحك تاوو    تمعة و لماليووة  لمعوو  لخطوو  

فعووول أع ة   ن  نظ تهوووا  لماليوووة  لعوووام  ت جههوووا  وقتاووواعي
ة فووووو  فانلووووو لقووووو    ل ت جهوووووات ةت جمووووومهموووووة بسياسوووووية 
معتمووووعة   سوووومية( ة)خُوووووطة ماليووووتب  وتعووووحيووووث  ن لمجتموووو 

ونفيذ ب نووووامج تووووفوووو   ةمطل بووووقات  لوقعي   لنفوووووتوووول ةضوووومن مُ 
تقوووعي   قيووو  ع ت  يضوووا     لشووواملة لنافوووة فعالياتهوووا ةهيئووو ل
تم ةلهوووا خووولا  سووونه  اوووي ـوووذ   لنفقوووات   مطل بوووة لسوووع  ل
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 تهيئووة م  ونووة شووه ةة يجووب تقووعي   نووع ع لأن ماليووة قاعمووة
 . قنفا،  مااع   لعخل  كلا من

 أنووووع عت  لشووووه ةة   لسوووون ية    لبيانووووا تهيئووووة أن
قاف لضوووو  ب  و فوووويووووتم  لأع    حووووعع لتوووو  تُ   لق  نووووع   لأسووووس

ن  لت حيوووووولن حوووووواوت  لتسووووووجيل ن ن   محووووووععة يماتوتعلوووووو  
 سوووسلقوووو  نع   لأُ لتوووتم أسوووتناع    لمب بوووة  لاووو و   لقوووبم

 [4] .ظام  ل قاب ون   لن لمحلية   لع لية لمحاسبية 

 مفهوم البيانات المالية
 لبيانوات   لمعل موات  لماليوةمُونظم لنو م  ـ 

للم كو  لمال  للع ئ ة   لذي يعكس  وع     وع  ة للم   ع 
   لم كله لها  تعفقاتها  لنقعية للمسخعمين لأتخاذ  لق   ت.

سمت  لحسووووووابات فوووووو   لنظووووووام  لمحاسووووووب   لحكوووووو م  وقُوووووو
 GFSاا  ت ماليوووة  لحك مووووة وق مووو  عليوووول  حوووو  لمت  فووو

 :إل 
 لم جوووووووو ع ت  -3 لماووووووو  فات    -2 ويووووووو  ع ت    -1

  .(3)  لمطل بات  لمالية -4 لمالية   
 )الاكسل( تطبيق الجداول البيانية

ع بو  مج و ح Microsoft Excel تب  ب نامجوعيُ 
 لبيانووات تعامل موو  و لتوو  ت وو  لمهمووة ت  نيةو قلنوو  لجووع   
  وشوووكا   مخططووواتة   لحسوووابي ل  لعمليوووات  ميةو ل قووو

تها و م  جعوعالجة  لبيانات  تحليلهوا مُ ة لخعمستو لبيانية  لم
جووووع     لحسووووابات  لماليووووة ك نووووع ع  جوووو   لأ  بفعاليووووة. 
 ل ظووووووووائف  لماليووووووووة    لتقعي ةووووووووة - لم  ونووووووووات  ل   تووووووووب   
خ جووووات  لماليووووة   لمُ  لبيانووووات ـووووذ  تمثيوووول موووو   لمختلفووووة 

ووا  تقووا ة   حاووائيه بمخوووططات أ   سوو م بيانيووة  ن غي ـ
 للمهوام  ذ تيذ  لوونفووت ل  بيانات وع  لوو  نووق خاايةمن خلا  

 [5] .) لمُختووت(   و لمانآلية تخع م وسبأ
 Macroرو ــالماك

 Excelمووون أ  موو   لآنسووول  ـوو  تسوووجيل لعووعع
[6]نكووووو    سوووووتخع مها باووووويغة متسلسووووولةي لتووووو  

نع و نووووو  
 بتنفيوووذ ـوووذ  تلقائيوووايقووو م  لمطلووو ب    و لمانووو تشوووغيل آمووو 
خووولا  مووون ن محوووععفووو  آمووو   -مخونوووة–هوووا لن ن لأ  مووو  

ـنووواك أن نلاحووو   لمسوووتم    لمتنووو   قنسووول نا م سوووتخعأ

 ط  توخوو ل لعووعع موون ةضوومنم لمكوو  ة   موون  لمهووام  نثيوو  ل
 موون  وفضوولفنليووه    لآموو ن فيهووا ذ فوو  كوول موو ة ننفووذ تُهووا 
ليووووتم   لمووووان   سووووتخع مـووووذ   لمهمووووة بأأ  ب مجووووة أتمتووووة 

هووووذ  تسووووجيل ل بتثبيووووت قوووو م يووووث نن حذ تيوووواف - لتنفيووووذ آليوووواف 
مموووا ن فقووو   لموووان   مووو تنفيوووذ آ ننوووع ا تشوووغيله  لخطووو  ت

  بالتووووال  يكوووو ن  ن لمكوووو  ة  ل  تينيووووة  لمهوووواميسووووهل كثيوووو   
 ـووووذ   لمهووووامأع    ننووووع هلك لمسووووت جهووووعتوووو في  ف لل قووووت  لل

 [7] . لمطل بة   لمهمة مالياف  لعقة م  ضمان ع  ةاف 
 الموازنة العامةجداول الملفات المستخدمة في 

  ع و  يوو 2018-  ع شووه  سووابقو ويوووووو  ع ت  لعامووة:  يوو -1
 2018-وحقه  ش

  ع و  يووووقبوووول تنفيووووذ  لمووووان   - 8آبه    ع شووووو) يوووو أي    
 .بعع تنفيذ  لمان  (- 9أيل  شه  
 2018- لماو  فات  لعامووة: ماوو  و شووه  سووابق -2

 2018-وحق ما  و شه  
قبوووووول تنفيووووووذ  لمووووووان   - 8آب )ماوووووو  و شووووووه  أي    
 .(بعع تنفيذ  لمان  - 9أيل  شه   ما  و  
 2018-ميوووو ن  لم  جعوووة  لعوووام: ميوووو ن شوووه  سوووابق -3

 2018-وحق ميو ن شه  
 مووويو ن  قبوول تنفيووذ  لمووان   - 8آب)مووويو ن شووه   أي    
 .(بعع تنفيذ  لمان  - 9أيل  شه  

 الجانب العملي -المبحث الثاني /ثانيا 
ـــم أعـــقـــد ل ـــامجـت ول الحســـاب جـــدمنفصـــلين ين داد برن
 وهما: العامة موازنةال
( 1 قم )بال  اشك  (الخاص-المفرد)جداول ل برنامج -1
 لأقسام   أ لف نية ف  كافة  لع  ئ    لذي يتم تنفيذ  شه ةا  

 ن لتابعوووه للمةسسوووة أ   لوووع ئ ة  ل ئيسوووية بالم  ونوووة نيةو لمعووو
 حسوووواباتل 50  48ين بووووـنووووا  ـانووووعع يووووعحعحيووووث تووووم ت
ن ثوووم ( لميوووو ن-3     و لماووو-2    لأيووو  ع-1)جوووع    
 لمةسسوة     لجوع     لمنفوذ  بعوع ذلوك لوعي  ن  ـذ  ت سل
شوعبة ف لقسم  لمال   - لمعنية أ   لش كة  ع ئ ة  ل ئيسية ل

                                               لم  ونة.



 2020الـسـنـة         2الـعـدد          12مـجـلة كـلـيـة مـديـنـة الـعـلـم                        الـمـجـلـد 

42 

 (2)أشكا  بال قم ( امالع-جماليالأ)جداول برنامج ل -2
 أ  لهيئة  لع ئ ة  ل ئيسية  لذي يتم تنفيذ  شه ةا ف  عي  ن 

طيات وعمُ  لكافة  أعخا  يتم تجمي  بعع أن ن حا  ف 
( خاص-) لمف ع -1  لفق ةجع    ب لم سلة   لمعخلات 

(  لميو ن-3   لما  و-2   لأي  ع-1)من  للن
 نف   نلا  م  ونةنية بالو لمع لف نية  لتابعة لها لع  ئ  ل

نل ل  لعي  ن  لأجماليةنسخه بيتم أعخالها جميعا حيث 
-3 لما  فات   -2 وي  ع ت   -1جع    )من  ل

 .ميو ن  لم  جعة  لعام(
 الموازنة ولاجد عدادالعامة لأصيغة ال
-2     عويوووووووو لأ-1) ة لمعنيوووووووو    يئة  لجووووووووعوهووووووووتيووووووووتم  -
-2  ةالمفــرد-1)تيه وميووو ن( بنسخوو ل-3   ماوو  و ل

 لتاووميم   لشووكل  لعوووام حيوووث  كوواملا موون (الأجماليــة
 لتب ةبوووات فيموووا يخوووص تحعيوووع ة  لمطل بوووة فوووق  لاووويغ    
أ   لووع ئ ة  موون قبوول شووعبة  لم  ونووة لمحووععة  لتاووانيف   

فمووثلا حووععت  لجووع    ـنووا  .لنوول جووع    لمعنيووه بووالآم 
 كما يل :

  الخاص(-)المفردجداول  -1
ت ميووووووو ـيكوووووول    179-8 موووووون سووووووط : يووووووو  ع لأ-1-1

 . وي  ع ت  لمت  فق م   لتب ةب  لع ل  -حسابات
ت ميووو ـيكوول    327-8موون سووط  :  لماوو  و-1-2

 . لماا ةف  لمت  فق م   لتب ةب  لع ل  -حسابات
ت ميوووووو ـيكووووول   241-10مووووون سوووووط :  لميوووووو ن-1-3

 = = = لم ج ع ت   لمطل بات  لمت  فق  -حسابات
 العام(-)الأجماليجداول  -2
ت ميووو ـيكوول    179-8موون سووط  :  تيووو  ع لأ -2-1

 . وي  ع ت  لمت  فق م   لتب ةب  لع ل  -حسابات
ت ميووووووو    327-8 موووووون سووووووط : اتماوووووو  ف ل -2-2

 لماوووووا ةف  لمت  فوووووق مووووو   لتب ةوووووب  -ـيكووووول حسوووووابات
 . لع ل 

ت ميووووو   241-10ن سووووط : مووووم  جعووووةميووووو ن  -2-3
 لمت  فوق =  لم جو ع ت   لمطل بوات   - ـيكل حسوابات

  = = 

حسوووووووب  لتب ةبوووووووات كووووووولا تم أنطوووووووا  لووووووو ن خووووووواص يووووووو -
لتسوهيل مع فوة  لمسوت يات   ل ئيسوية   لف نيوة  لتانيفات 

ننوع   لسو نة  ضمان  لعقةل   ننع  لأعخا   تجنب  لخطأ
فوو    لتوو  يووتم أعخالهووا   لمطل بووة  لشووه ةة  لبيانووات تهيئووة

مثوول  لفا غووة فقوو خلايووا  ل
 .  لخلايا  وخ   للمعاعوت كلا حسب كل جع  

 :المعادلات الرياضية
 لمعتموووعة فووو  : (خـــاصال-المفـــرد)جـــداول نســـخ   -1

يوتم حيوث ن  لقسم  لمعن أ   لف نية أ  كليةن معهعن  لع ئ ة 
فووو   لخلايوووا  لمطل بوووة  ل ةاضووية  عاعوتو لموووكافوووة تثبيووت 

 لخلايووا ة   لتوو  تظهوو  فوو  معونوو لأمحووععة موون  ل   قولحوول
 نأ   بهووووووووووووووذ   لاوووووووووووووويغة

 لسووابق ال    وحووشووه   ل لمعوواملات ) تشوومل ـووذ   لأنمووعة 
بة و نسو بق  مون  لتخاويصو  لمتو  لحوال م   لغاية و لمج  
ع    لجوحقو   كولا حسوب  (.. حسواب  ل اويع... فيذو لتن

 ن  كما سيتم ت ضيحه تبانا. لمعن 
 -أ( -1-1) الشــكل - (2018)الأيــــراد جــدول  1-1

  (سط  172لجع    وال  سط  من   47 ظها )تم 
    ي  ع ت  لشه   لحال   G و نم ع
 لأ لو  للعمو ع..  لتاليوة فو   لخلايوا  لمعاعوت ت يتثبيتم 

كووووذ  نسوووووتم  بتثبيووووت كافوووووة  لمعوووواعوت لبقيوووووة  لخلايوووووا   ـ
( معاعلوووةن حيوووث 52 لحوووال   نوووععـا )– لمطل بوووة لعمووو ع

ال ن  لنيلوووو  جموووو  بوووو 1 لمسووووت   تمثوووول معوووواعوت  لخلايووووا 
ا جموووو بوووو 2 لمسووووت   لخلايووووا   ال ن  وحموووو    لتوووو  بووووع  ـ

 ن للخلايووووا بووووال ن  لوووو  عي   لتوووو  تجموووو   لتوووو  تليهووووا بووووال
كووذ  لبقيووة  ا  لوو ن  لمووا ي..  ـ  واووف    لتوو  تجموو  بووع  ـ

  لخلايا.
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                        G8=SUM(G9,G40,G44,G134)      

  G9=SUM(G10)      

  G10=SUM(G11,G19,G22)      

  G11=SUM(G12,G15)      

  =SUM(G13,G14) G12     

      

  =SUM(G16:G18) G15     

  G19 =SUM(G20)     

  =SUM(G21) G20     

  G22 =SUM(G23,G29,G34)     

  =SUM(G24:G28) G23     

  =SUM(G30:G33) G29     

  =SUM(G35:G39) G34     

  G40=SUM(G41)     

  G41=SUM(G42)     

  =SUM(G43) G42     

 G44=SUM(G45,G53,G107,G120)     

  G45=SUM(G46)     

         =SUM(G47:G52) G46     

 G53=SUM(G45,G72)     

 فارغة للأدخال فقطخلايا 
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  لخاص(-) لمف ع    لأال  –( أ-1-1) الشكل( 2018الأيراد -1-1جدول )
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 G54=SUM(G55,G58,G63,G69)     

         =SUM(G56:G57) G55     

  
          

                          لحال . عم ع  لشه ل بالخلايا  لمطل بة (معادلة 52)نستم  بتثبت  لمعاعوت  نععـا 
     

                                                                                                                                                                       خلايا  فا غة  -سابقايرادات الشهر ال/  H عمود ـ
      I8=SUM(G8,H8)                                      المجموع لغاية الشهر الحالي/  I عمودـ 

 .(172( نععـا   لعم ع خلايا لمعاعلة تجم   ي  ع  لشه   لحال    لسابق  تن    لمعاعلة لنافة 
 فه  خاص بب نامج  لمان   فق . J وخي - ما نم ع  لمعاعلة* 
 (سط  320    لأال سط  من  لجع   31)تم  ظها  - أ(-2-1) الشكل - (2018لمصروف )اجدول  1-2

  H8=SUM(H9,H242,H292)      

  H9=SUM(H10,H72,H143)      

H10=SUM(H11,H49,H55,H59)      

  SUM(H12)  H11=     

H12=SUM(H13,H23)      

  H13=SUM(H14)      

  H14=SUM(H15:H22)      

     

  H23=SUM(H24:H48)      

  H49=SUM(H50)      
      

   ات الشهر الحاليمصروف/  H عمودـ 

كذ  نستم  بتثبيت كافة  لمعاعوت لبقية  لخلايا  لمطل بوة لعمو عأنلا  خلايا  لمعاعوت  لأ ل  للعم ع            لحوال  - ..  ـ
 حموو   ن  ول لفوواتح جمو  للخليووة بوال   ن  لبنفسوجلفالخليوة بووالمعووينن مسوت    حيوث تمثوول كول معاعلووة ن( معادلــة83) نوععـا 

ا جموو  للخليووة بووال ا    عيل ن  لوول ن  ل اااوو    لتوو  تجموو   لخليووة قبلهووا بووال  لتوو  بووع  ـ  ن لبووالخليووة  ل  لتوو  تجموو  بووع  ـ
كذ  لبقية  ..ـ  جم  للمعخلات  لشه ةة  لت    ن  لما ي للخلية  ـ  جم  ل   لنيل    لل ن   واف   لت  تجم  خلية  خلايا ـ

  لمعاعوت.
 
 خلاياه فارغة                                                                                                      -الشهر السابق منلمدور / ا I عمودـ 

   J8=SUM(H8,I8)                                                 المجموع لغاية الشهر الحالي/  J عمودـ 

 .320الشهر الحالي والسابق وتكرر المعادلة لكافة خلايا العمود وعددها  مصروفاتتجمع  المعادلة

                                                                                                                                                 أدخال البيانات المطلوبة لاحقا -سنويةلا تخصيصاتال/  K عمودـ 

   L8= K8-J8                        تكرر المعادلة لكل خلايا العمود -متبقي من التخصيصال/  L عمودـ 

   M8= J8/K8*100                            تكرر المعادلة لكل خلايا العمود -نسبة التنفيذ/  M عمودـ 
 
    فهو خاص ببرنامج الماكرو فقط. Nالاخير-اما عمود المعادلة* 

 

 فارغة للأدخال فقطخلية  

 

 

: 

: 

: 

: 
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  لخاص(-) لمف ع    وال  – أ(-2-1) الشكل - (2018المصروف -2-1جدول )
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 (سطر 232 ل الأصليسطر من الجدو 36)تم اظهار - (أ-3-1) الشكل - (2018 لميزان)اجدول   1-3

 H10=SUM(H11,H31,H58,H76,H84,H94,H97)      

 I10=SUM(I11,I31,I58,I76,I84,I94,I97)      

  H11=SUM(H12,H13,H30)      

  I11=SUM(I12,I13,H30)      

                                                   H13=SUM(H14,H17,H21,H25,H28,H29)      

                                                             I13=SUM(I14,I17,I21,I25,I28,I29)      

  H14=SUM(H15,H16)      

  I14=SUM(I15,I16)      

 
   

  H17=SUM(H18:H20)      

  I17=SUM(I18,I20)      

  H21=SUM(H22:H24)      

  I21=SUM(I22,I24)      

  H25=SUMH26:H27)      

  I25=SUM(I26,I27)                                                       H31=SUM(H32,H37,H43,H49,H53,H57)     

                                                             I31=SUM((I32,I37,I43,I49,I53,I57)     

                                                                                  H32=SUM(H33:H36)     

                                                                                       I32=SUM(I33:I36)     

 

  ت الشهر الحاليمعاملا /I  وH  عمودـ 
كووذ  نسووتم  بتثبيووت كافووة  لمعوواعوت لبقيووة .. ينللعموو ع  لووع ئن  لمووعين   لحقلووأنوولا  خلايووا  لمعوواعوت  لأ لوو    ـ

ن حيووث تمثوول معوواعوت  لخلايووا لنوول حقوول (معادلــة 63) نووععـا مووعين   لووع ئن( )لحقلوو   ل لحووال  ي  لخلايووا  لمطل بووة لعموو ع
ا جمو  لخلايوا بوالاف ن  ولجم  لخلايا  ل وحم   لفاتحل ن  لذ ت   ل ن لبوا    لتو  تجمو   لتو  تليهوا نيلو ن  لل    لتو  بوع  ـ

كذ  لبقية  لخلايا. لبيضا  خلايا  وعخا   لت  تجم     عي ل  ..  ـ
 
                                                                                   غة                     خلاياه فار -/ ايرادات الشهر السابق Kو   J عمودـ 

         =01J,0H1SUM(L10(                                   لغاية الشهر الحاليالمجموع /  Mو  L عمودـ 

10)K10,I10=SUM(M         

 .بحقليه المدين والدائن (232) وتكرر المعادلة لكافة خلايا العمود مدورالشهر الحالي وال معاملاتالمعادلة تجمع 

  لغاية الشهر الحالي رصيدال / Oو  N عمودـ 

 N10 =IF((+L10-M10)>0,(+L10-M10),0)         

              O10 =IF((+L10-M10)<0,ABS(+L10-M10),0)          

 .لنل نم ع خلية (232) نععـا  تن    لمعاعلة لنافة خلايا  لعم ع بحقليه  لمعين   لع ئن لحساب  ل ايع  

   لمان   فق . وخي  فه  خاص بب نامج - لمعاعلة- P   Q ي ما نم ع *

 فارغة للأدخال فقط

 

 

 

: 

: 
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  لخاص(-) لمف ع/   لأال  –أ( -3-1الشكل ) -( 2018الميزان -3-1) جدول
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   لت  لمعتمعة ف  عي  ن  لع ئ ة  ل ئيسية أ   لمةسسة أ   لش كة  لمعنية حا  فن :  العام(-)الأجماليجداول نسخة  -2 
 معاعوت  ل ةاضية  لمطل بة ف  خلايا لكافة يتم أيضا تثبيت ( حيث م  جعة ل ميو ن لما  فات   تشمل ) لأي  ع تن 

  لعملية نل ن  تن    أ  بالايغة  لتالية  لت  تن ن   جع  ن  لمحععة لنل  لأنمعة 
نا حععنا نععـا بين   تثبيتأضافة  ل  ن للجع     لثلاث 50   48نوعع  لع  ئ   لف نية  لمعنية  لم تبطة معها  ـ

   ن   لمتمثلة بجم  كل  لأي  ع ت  لمتضمنة معاعوت حق    لحساب  لنل   لأجمال   لشه ي  لنل جع لمعاعوت 
كلا حسب  لجع   ن( لجمي   لأقسام   لع  ئ   لف نية  لمعنية أ   لم تبطة بها    لما  فات   لميو ن بحقليه ) لمعين   لع ئ  

   .كما مبين بالايغة  لتالية لمعن    
  لم تبطة بها. ـ  جم  لنل  ي  ع ت  لع  ئ   لف نية أ(-1-2) الشكل – (2018جدول )الأيرادات  2-1   
  / ايرادات الشهر الحالي G عمودـ  
                             ( حسب  لمعاعلة  لتالية.   48)   لبال  نععـا ـنا لشه   لحال  لنافة  لع  ئ   لف نية   تجم  كل  ي  عيتم    

       .خلية 172لباق  خلايا  لعم ع  لبالغة  G8 لخلية معاعلة ثم نسخ 
 

G8=J8+M8+P8+S8+V8+Y8+AB8+AE8+AH8+AK8+AN8+AQ8+AT8+AW8+AZ8+BC8+BF8

+BI8+BL8+BO8+BR8+BU8+BX8+CA8+CD8+CG8+CJ8+CM8+CP8+CS8+CV8+CY8+DB8

+DE8+DH8+DK8+DN8+DQ8+DT8+DW8+DZ8+EC8+EF8+EI8+EL8+EO8+ER8+EU8       

 / ايرادات الشهر السابق                                                                                                        H عمودـ 

                          ( حس  المعادلة التالية.     48يتم جمع كل ايرادات الشهر السابق لكافة الدوائر الفرعية والبالغ عددها هنا ) 

      .خلية 172لباقي خلايا العمود البالغة  H8الخلية معادلة ثم نسخ 

 
H8=K8+N8+Q8+T8+W8+Z8+AC8+AF8+AI8+AL8+AO8+AR8+AU8+AX8+BA8+BD8+BG

8+BJ8+BM8+BP8+BS8+BV8+BY8+CB8+CE8+CH8+CK8+CN8+CQ8+CT8+CW8+CZ8+D

C8+DF8+DI8+DL8+DO8+DR8+DU8+DX8+EA8+ED8+EG8+EJ8+EM8+EP8+ES8+EV8 

   I8=SUM(G8,H8)                                            المجموع لغاية الشهر الحالي/  I  عمودـ 

 .172لنافة خلايا  لعم ع  نععـا I8  لخلية معاعلة لسابق  تن    ت للشه   لحال   لي  علأ لمعاعلة تجم    
لنل ع ئ ة    لمتضمن 48  لبال  نععـا ـنا  لف نية نافة  لع  ئ  جع    وي  ع لشمل ي EWالعمود  الى Jالعمود  بدا منـ 

 حسب  لمعاعوت كافة  (جم   لغاية  لشه   لحال  ي  ع ت  لشه   لحال    لسابق   لم) بالبيانات  ـ أنمعة  3منها ف نية 
ا لجع    وي  ع نسخه  لمف ع   لخاص بالع ئ ة  لف نية. -  لت  سبق ذك ـ

  وخي  فه  خاص بب نامج  لمان   فق .- لمعاعلة EX ما نم ع * 



 2020الـسـنـة         2الـعـدد          12مـجـلة كـلـيـة مـديـنـة الـعـلـم                        الـمـجـلـد 

50 

 
  لعام(-) وجمال /   وال  –أ( -1-2الشكل ) -( 2018-الأيرادات  -1-2جدول )

 



 2020الـسـنـة         2الـعـدد          12مـجـلة كـلـيـة مـديـنـة الـعـلـم                        الـمـجـلـد 

51 

  .ـ  جم  لنل ماا ةف  لع  ئ   لف نية أ(-2-2) الشكل - (2018جدول )المصروفات  2-2
  ات الشهر الحالي مصروف/  H عمود ـ 
 ( حسب  لمعاعلة  لتالية.48 لشه   لحال  لنافة  لع  ئ   لف نية   لبال  نععـا ـنا) فا ةمايتم جم  كل  

                     خلية. 320لباقي خلايا العمود البالغة  H8 الخليةمعادلة ثم نسخ  

 

H8=N8+S8+X8+AC8+AH8+AM8+AR8+AW8+BB8+BG8+BL8+BQ8+BV8+CA8+CF8+C

K8+CP8+CU8+CZ8+DE8+DJ8+DO8+DT8+DY8+ED8+EI8+EN8+ES8+EX8+FC8+FH8+

FM8+FR8+FW8+GB8+GG8+GL8+GQ8+GV8+HA8+HF8+HK8+HP8+HU8+HZ8+IE8+IJ

8+IO8 

 الشهر السابق المدور من/  I عمودـ  

 ( حس  المعادلة التالية.48) لكافة الدوائر الفرعية والبالغ عددها هنا السابقدور للشهر ماليتم جمع كل   

                                                  خليوووووووووووووووة.   320لبووووووووووووووواقي خلايوووووووووووووووا العموووووووووووووووود البالغوووووووووووووووة   I8الخليوووووووووووووووة معادلوووووووووووووووة  تكووووووووووووووورارثوووووووووووووووم  

 
 

I8=O8+T8+Y8+AD8+AI8+AN8+AS8+AX8+BC8+BH8+BM8+BR8+BW8+CB8+CG8+CL

8+CQ8+CV8+DA8+DF8+DK8+DP8+DU8+DZ8+EE8+EJ8+EO8+ET8+EY8+FD8+FI8+FN

8+FS8+FX8+GC8+GH8+GM8+GR8+GW8+HB8+HG8+HL8+HQ8+HV8+IA8+IF8+IK8+I

P8                                                                                                                        

 

  H8:I8=SUM(J8(                                     / المجموع لغاية الشهر الحالي J عمودـ 
 .320 لشه   لحال    لسابق  تن    لمعاعلة لنافة خلايا  لعم ع  نععـا  ا ةفماتجم   J8  لخليةمعاعلة  
                                                                                                                                                 .ف  خلايا  لعم ع  لأعخا   لبيانات  لمطل بة -التخصيصات السنوية/  K عمودـ  

   L8= K8-J8        لنل خلايا  لعم ع L8 ة لخليمعاعلة تن    -/ المتبقي من التخصيص L عمودـ  

     M8= J8/K8*100   لكل خلايا العمود M8 ةمعادلة الخلي تكرر -نسبة التنفيذ/  M عمودـ  

لنل    لمتضمن 48نافة  لع  ئ   لف نية   لبال  نععـا ـنا ل    لما  و  جعشمل يIS  الى العمود  Nبدا من العمود ـ  
  لتخاياات  لسن ية   لمتبق   ات  لشه   لحال    لسابق   لمجم   لغاية  لشه   لحال )ما  فأنمعة  ـ   5ع ئ ة منها 

 . لخاص -بالبيانات   فق  لمعاعوت لجع    لما  و  لمف ع  من  لتخايص(
  وخي  فه  خاص بب نامج  لمان   فق .- لمعاعلة  ITنم ع ما   *
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 العام(-)الاجمالي   وال ا –ب( -2-2الشكل ) -( 2018المصروفات  -2-2دول )ج
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  .هو جمع لكل موازين الدوائر الفرعية (أ-3-2) الشكل - (2018 ميزان المراجعة العام)جدول  2-3

 / معاملات الشهر الحالي  Iو  Hـ عمود 

                          ( حسب  لمعاعلة  لتالية.     49لشه   لحال  لنافة  لع  ئ   لف نية   لبال  نععـا ـنا ) لمعين   لع ئن ليتم جم  كل  

   .(232( لبالغة  Hلباق  خلايا  لعم ع المدين - H10ثم نسخ معاعلة  لخلية 

  
H10=P10+X10+AF10+AN10+AV10+BD10+BL10+BT10+CB10+CJ10+CR10+CZ10+DH1

0+DP10+DX10+EF10+EN10+EV10+FD10+FL10+FT10+GB10+GJ10+GR10+H250+P250+

X250+AF250+AN250+AV250+BD250+BL250+BT250+CB250+CJ250+CR250+CZ250+D

H250+DP250+DX250+EF250+EN250+EV250+FD250+FL250+FT250+GB250+GJ250+GR

250    

                                           .خلية 232نععـا  I لعم عخلايا  ل الدائن- I10معاعلة  لخلية   تن   

I10=Q10+Y10+AG10+AO10+AW10+BE10+BM10+BU10+CC10+CK10+CS10+DA10+DI

10+DQ10+DY10+EG10+EO10+EW10+FE10+FM10+FU10+GC10+GK10+GS10+I250+Q2

50+Y250+AG250+AO250+AW250+BE250+BM250+BU250+CC250+CK250+CS250+DA2

50+DI250+DQ250+DY250+EG250+EO250+EW250+FE250+FM250+FU250+GC250+GK2

50+GS250 

 / المدور من الاشهر السابقة Kو  J عمودـ 

 .( بالمعادلة49) جمع كل المدين المدور للأشهر السابقة لكافة الدوائر الفرعية والبالغ عددها هنا J10بالخلية يتم 

 
J10=R10+Z10+AH10+AP10+AX10+BF10+BN10+BV10+CD10+CL10+CT10+DB10+DJ10

+DR10+DZ10+EH10+EP10+EX10+FF10+FN10+FV10+GD10+GL10+GT10+J250+R250+

Z250+AH250+AP250+AX250+BF250+BN250+BV250+CD250+CL250+CT250+DB250+D

J250+DR250+DZ250+EH250+EP250+EX250+FF250+FN250+FV250+GD250+GL250+GT

250    

 خلية. 232عددها و K الدائن ايضا للعمودمعادلة الجمع لكل خلايا  وتكرار

   المجموع لغاية الشهر الحالي/  Mو  L عمودـ 

  L10=SUM(H10,J10)       تجمع معاملات المدين للشهر الحالي والمدور L10معادلة خلية 

  M10=SUM(I10,K10)     تجمع معاملات الدائن للشهر الحالي والمدور M10معادلة خلية 

 .خلية 232عددها و كافة خلايا العمود بحقليه المدين والدائنلحسا  المجموع  ل وتكرر المعادلة ل
 
 لغاية الشهر الحالي رصيدال /O و N عمودـ 

  N10=IF((+L10-M10)>0,(+L10-M10),0)               المدين رصيد N10معادلة خلية 

       O10=IF((+L10-M10)<0,ABS(+L10-M10),0)   الدائن رصيد O10معادلة خلية 

 لكافة خلايا العمود بحقليه المدين والدائن.لحسا  الرصيد تكرر المعادلة و

  الاخير فهو خاص ببرنامج الماكرو فقط.- المعادلة  HAو  GZ اما عمود  *
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  لعام(-) وجمال  /  وال ا –أ( -3-2الشكل ) -( 2018المراجعة ميزان  -3-2جدول )
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 بنوعيهـا الـثلاث الموازنـةول الجـد الماكروصيغة تهيئة 
 )المفرد( و )العام(

المتضـــمن للجـــداول /  (الخـــاص-المفـــرد) دولـجـــ -1
 التالية:

قبووول ( ب-1-1) الشـــكل -( 2018   عووووو) لأي 1-1     
  لمان  تنفيذ  بعع (ج-1-1) الشكل  لمان   تنفيذ 
 (2018   وو) لما 1-2     
    (2018 يو نو لم) 1-3     
حسووابات يو وت مووسووط  بيانووات  لنبيوو  لأعع وعووبووالنظ  لل -
نموووعة  لتاوووانيف  لجانبيوووة  لت ضووويح  لآمووو ن لأيكل   و لهووو
تثبيوت     ننوع أنوع ع ب نوامج  لموان    مون  لأفضولفمون 

 ن ثوومبينهمووا  وسووط   Hide  خوو  سووط  بيانووات   خفووا 
 وسووط  أي تثبيوت Panes   Freezeيوع  ولو  ح تجم

 لتاوووووونيف  لووووووع ل    لعل يووووووة  لمعووووووون نة للجووووووع    أنمووووووعة
بالأمكووووان تثبيووووت خليووووة  لتقوووواط  بينهمووووا ليووووتم  لجانبيووووةن   

ية(   لعمو ع وق    ل ئيسووتجميع  لسط   لعل ي )معون ن  لح
ضو   لمةشو  ةوتم      لجانب  )معون ن  لتاانيف  لعامة(ن 

يانات فوو   لعموو ع  لمعووون ن بووو) لمجم   ونلوو      خليووة بوو
 لغاية(.

 الخطوة الاولى
 بتشغيل ) لتسجيل( للمان   لبعأ  -
 Menu→View →Macros → Record macro 

 حسب ن    لجع  كلا مان   ب نامج  للأنطا   سم  - 
( 2018)ميو ن( أ 2018)ما  ون (2018مثلا )أي  ع

 .جع  ال لخاص ب ب نامجع ع  لوأن -الخطوة الثانية
 [8] .   يقاو تسجيل  لمان -الخطوة الثالثة

ب نوووووامج  لموووووان    لخووووواص  أنوووووع ع بعوووووع  لأنتهوووووا  مووووون -
يغة  لموووووان  ن باووووو ملوووووف ل يحفووووو ن  لموووووذك  ة    جوووووعبال

- لمفوو ع)-1 نوو  تنوو ن فووايلات  لم  ونووة  لووثلات  بالتووال  
  و ماووووو ل-2-1  ويووووو  ع -1-1) ( لجوووووع    لخووووواص

 فيذ  لآلوووووو ومهيوووووأ للعمووووول باووووويغة  لتنووووو ( لميوووووو ن-1-3 
 .شه ةا
 (أ-1-1)كل  لشوووو( 2018 ويوووو  ع -1-1) جووووع  أن  -

 لمطل بوة لمعاعوت متضمنا   - وال   قع سبق ذك   
 مهيووووأ لأعخووووا   لبيانووووات فوووو  خلايووووا   ة نووووامج  لمووووان  

  لأعخا   لفا غة  لمحععة فق . 
ن حيوووث تووم  ظهوووا  نموو ذم مختاووو  منووهـنوووا  / ملاحظــة

لت ضوووويح  سووووط  فقوووو  موووون ت ميووووو ـيكوووول  لحسووووابات 47

يكوووو ن ب نلمووووا بووووأن  لنموووو ذم  لأاوووول   لفووووا   ن  لآموووو 
لجوووووع       ةووووونفس  لسووووويا، فيموووووا يخوووووصن سووووط ( 172)

-3-1 لماووووووووو  و  -2-1 ويووووووووو  ع  -1-1) ة لثلاثووووووووو
كووووولا حسوووووب  ياناتو بالبووووو أي فا غوووووة-يةو والووووو  لميوووووو ن(
 .ن نه

آلية عمـل وتنفيـب برنـامج المـاكرو فـي جـداول الموازنـة 
 العامة بنوعيها )المفرد( و )العام(   

الخـــاص( / والجـــدول الملعتمـــد للتوضـــي  -)المفـــرد -1
 (2018-8أي  ع آب-1-1)
  لجع   -ننع فتح  لفايل -

Security warning - Options → Enable this 

content  → OK 

يووووتم أعخووووا   لبيانووووات  لمطل بووووة فوووو  حقوووو    لأعخووووا   -
كمووا   لمحوععة فوووق  لعمو ع ) لشووه   لحوال ( فوو   لجوع  ن

ممثوول بالشووكل  (2018-8الأيــراد آب1-1) جــدول  فوو
 (  ب-1-1)
 (.2018يتم تنفيذ ب نامج  لمان    لخاص بأسم )أي  ع -

Menu → View  → Macros → View 

Macros → File name → Run   

 قميوا فووق  مون  –بعع تنفيذ  لمان   سيتم نقل  لبيانات  -
 نم ع ) لمجم   لغاية(  ل  نم ع ) لشه   لسابق(. 

 سيتم تافي  نم ع ) لشه   لحال ( من  لبيانات. كذلك 
 ع ئمووا  وختيووا  يكوو ن باوويغة  لموووان   يخووون  لفايوول  -

ليكوووو ن فعوووواون  ةخووووون بأسووووم  لشووووه   للاحووووق للحووووال ن 
 (2018-9)أي  ع أيل   -فيك ن  لأسم

OfficeButton → Save As  → Excel 
Macro_Enabled Workbook  

 ل   لشه   8 لسابق آب لآن تم ت حيل بيانات  لشه   -
ن  نليه سيك ن  لجع   مهيأ لأعخا  9 للاحق أيل  

 جع  بياناته للشه   للاحق حينهان كما م ضح ف  
-1)ممثل بالشكل ( 2018-9أيلولالأيراد -1-1)
 أي أن( ج-1
( ب-1-1) الشــــــكل( 2018 ويووووو  ع -1-1) جـــــدول -

 تنفيذ  لمان  .   قبل - 8متضمن  عخا  بيانات شه  آب
( ج-1-1) الشــــــكل( 2018 ويووووو  ع -1-1) جـــــدول -

 تنفيذ  لمان  .   بعد - 9مهوويأ بوالوبويانوات لشوه  أيول  
 لمطل بة ف  نفس  لايغة تتب  ننع أعخا   لبيانات  -

  لشه   لحال حق    لأعخا   لمحععة فوق  لعم ع 
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ن 2018-8لجع ل   لما  و   لميو ن لشه  أب
 . ن   لنل جع   منهما  يضا ف  آلية تنفيذ  لما

-1 لما  ون 2-1 لأي  عن1-1) لثلاث ـ  لجع     
  لميو ن(.3

 

 قبل تنفيذ  لمان   - 8بيانات شه  آب -( ب-1-1) الشكل( 2018الأيراد -1-1) جدول  
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 ع تنفيذ  لمان  وبع - 9بيانات شه  أيل   -( ج-1-1) الشكل( 2018الأيراد -1-1) جدول  
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المتضمن للجداول / ( امعال-جماليالأ)جدول  -2
      التالية:

قبول  (ب-1-2) الشكل -( 2018) لأي  ع ت  2-1    
 قبل تنفيذ  لمان   (ج-1-2) الشكل  تنفيذ  لمان  

 ( 2018) لماو  فات  2-2    
 (2018  لم  جعة )ميو ن 2-3    
 لنلوووو (  -) لعووووام-2بووووالنظ  للحجووووم  لنبيوووو  للجووووع     -

حسوووابات  أنموووعة ت ميوووو ـيكووول  لعع  سوووط  بيانوووات و لتعووو
مكوووان تثبيووووت  لت ضوووويح  لآمووو ن بالأ لتاوووانيف  لجانبيوووة 

 بينهموا.  وسوط   Hide      خو  سوط  بيانوات   خفوا 
 وسوط   لعل يوة تثبيوت  أي Panes  Freeze  تجميوع

 لمعووووون نة للجووووع    أنمووووعة  لتاوووونيف  لووووع ل   لجانبيووووةن 
ميع وقاط  بينهموا ليوتم تجوويت خليوة  لتوو كوذلك بالأمكوان تثبو

ية(   لعمووووو ع وق    ل ئيسوووووو لسوووووط   لعلووووو ي )معوووووون ن  لحووووو
  لجانب  )معون ن  لتاانيف  لعامة(. 

 ضوووو   لمةشوووو  نلوووو      خليووووة بيانووووات فوووو   لعموووو ع  -
 .لأ   ع ئ ة ف نية  لمعون ن بو) لمجم   لغاية(

 الخطوة الاولى
 مان    لنامج لب   لبعأ بتشغيل ) لتسجيل(  -

Menu →View→ Macros → Record macro 

 حسب أسم  لجع  كلا لمان   امج  ب نأنطا   سم ل -
( 2018) لما  فات ن(2018مثلا ) لأي  ع ت

 (ن2018  لميو ن
 لخاص بالجع    ب نامجأنع ع  ل ـ  الخطوة الثانية

 لذي يتضمن ب نامج نسخه  لمف ع  يك   نل    لمعن 
 .(49نعع ف     لع ئ ة   لبال  نععـا ـنا )

   لمان  .  لخون بايغة  تسجيل ل يقاو  الخطوة الثالثة
-2نووووووووو    لآن تنووووووووو ن فوووووووووايلات  لم  ونوووووووووة  لوووووووووثلات  -
-2-2   ت ويووو  ع-1-2)( لجوووع     لعوووام - لأجموووال )

للعمل   مهيأ ( لم  جعة  لعامميو ن -3-2   ات لما  ف
   [8]. لتنفيذ  لآل -بايغة  لمان  

 

المـاكرو فـي جـداول الموازنـة برنـامج آلية عمـل وتنفيـب 
    )المفرد( و )العام( بنوعيهاالعامة 

ــــال-جمـــاليالأ) -2 ـــد للتوضـــي  الجـــدول المل  /( امع عتم
  (2018-8آب يراداتالأ-2-1)
  لجع  -فايلننع فتح  ل -

Security warning - Options → Enable this 

content  → OK 

حقووو    لأعخوووا   يوووتم أعخوووا   لبيانوووات  لمطل بوووة لنافوووة -
 بالتسلسووولات   ق  لعمووو ع ) لشوووه   لحوووال ( و لمحوووععة فووو

 اتيــــرادالأ-1-2)  لتووووال  ع  ولجووووكمووووا فوووو    ـنووووان 48
ووووو ،(ب-1-2) كلالشـــــ ( 2018-8آب   مختاووووو  و ـ
-8آب)للشووه   لحووال (   لأيوو  ع تذي يمثوول جووع   و لوو  

2018  . 
بأسووووووووووووم  للملووووووووووووف لمووووووووووووان   ب نووووووووووووامج يووووووووووووتم تنفيووووووووووووذ  -
 (.2018أي  ع ت)

Menu → View  → Macros → View 

Macros → File name → Run   

 قميوووا فقووو   –بعوووع تنفيوووذ  لموووان   سووويتم نقووول  لبيانوووات  -
) لشووه   لسووابق(.  أنمووعة) لمجموو   لغايووة(  لوو   لأنمووعة

) لشوووووه   لحوووووال ( مووووون  ةعأنمووووو كوووووذلك سووووويتم تاوووووفي  
 .ـنا (48)نععـا  لت     ف   لنافة  ل  لبيانات

 ع ئمووا  وختيووا  يكوو ن باوويغة  لموووان   يخووون  لفايوول  -
أي  للاحوووق  بأسوووم  لشوووه    لخوووون يكووو ن ليكووو ن فعووواون 

ت يـــــراداالأ-1-2)  لتوووووال  جوووووع  كموووووا فووووو   ل 9أيلـــــول
   ج(-1-2) الشكل  (2018-9أيلول

OfficeButton → Save As  → Excel 

Macro_Enabled Workbook  

 2018-8آب لآن تم ت حيل بيانات  لشه   لحال   -
يك ن نليه سن   2018-9أيل   ل   لشه   للاحق 

 .حينها  لجع   مهيأ لأعخا  بياناته
ع ل  ونع أعخووووا   لبيانووووات لجوووووبوووو  نووووتنفوووووس  لاوووويغة ت *
ية وفووو  آلوووأيضووا    نيو ن  لم  جعووة  لعاموووةو مووو اوو  فات لم
  لمان   لنل جع   منهما.ب نامج فيذ وتن
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 قبل تنفيذ  لمان   - 8بيانات شه  آب -ب( -1-2الشكل ) -( 2018الأيرادات  -1-2جدول )
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 بعع تنفيذ  لمان   - 9بيانات شه  أيل   -ج( -1-2الشكل ) -( 2018الأيرادات  -1-2جدول )
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 مناقشة

الطريقة النمطية السوابقة  تباعنلاحظ مما تقدم أن مسألة أ 

اليدوية لحسا  جداول الموازنة آمر جودا صوع  بوالنظر 

الموازنات العاموة والتخصيصوات غ ـمبالبيرة لـالكلزيادة ل

الدوائر الفرعية المرتبطوة عدد وأتساع نوية من جهة ـالس

سوونويا موون جهووة آخوورا، وبالتووالي فووأن أعتموواد برنووامج 

حاسوووووبي لأعووووداد حسووووابات جووووداول الموازنووووة العامووووة 

يصووبآ آموور حتمووي ممووا يختووزل التنفيووذ الووذاتي  وبصوويغة

 الكثير من الجهد والوقت أضافة للدقة العالية في التنفيذ.

 لثالث/ المبحث اثالثا

 جات والتوصياتالاستـنتا

أستخدام أتمتة العمل المالي بأن يستنتج مما سبق    

الماكرو لأعداد جداول الموازنة العامة –لتلقائيالتنفيذ ا

يختزل الكثير من الوقت والجهد مع ضمان لسرعة 

 الحصول على البيانات المطلوبة بدقة عالية.

الاستفادة من البرنامج لأعداد  يةنامكوعليه يوص ى بأ

جداول الموازنة العامة لكل شع  الموازنة في الاقسام 

المالية لكافة الدوائر والشركات، وبالأمكان تنفيذه على 

كافة وحدات الانفاق الحكومية سواء المؤسسات 

والهيئات بالوزارات أوالجهات الغير مرتبطة بوزارة 

وكذلك  ،التابعة لهاالمختلفة  فروعوالأولجميع الشركات 

الدوائر التي يتم تمويلها من قبل الخزينة العامة للدولة أو 

أي جهه خارجية كهيئة او شركة.. ولكافة التصانيف 

وهياكل الحسابات والتبويبات المختلفة وبأي صيغة 

معتمدة للجهه المعنية، وأمكانية أجراء كافة التعديلات 

ة وبما يتلائم مع والتغيرات الدورية المستجدة والمستحدث

 أستخدامات أخرا.
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